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What’s New

TIME TO EXPLORE Welcome to OS X Mountain Lion 

One year has passed since Apple released Lion, the company’s seventh iteration of OS X, its Mac operating 
system. In that year, the company has broadened its sync service, iCloud; it has released the next generation of 
iOS for its tablets and phones, in addition to previewing iOS 6; and its OS X team hunkered down to polish and 
refine Lion’s rough edges into something smooth and—dare we say—beautiful.

The result: OS X Mountain Lion, aka 10.8. This version unifies the advances made in iOS, builds on iCloud, 
tweaks OS X’s applications, and takes yet another stride toward providing the ultimate security of its platform—
but this time, without compromising user freedom.

Mountain Lion’s changes aren’t as drastic or far-reaching as Lion’s, but they’re important in their own right. So 
we’ve put together a primer on what’s new in the operating system, how it works, and where you can get it. In 
this chapter, we’ll briefly discuss new features and changes coming to your system with Mountain Lion.

C H A P T E R  1
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What You Need to Know
Before you play with Mountain Lion, you have to know the basics: where to get it; how to install it on your sys-
tem; what user differences and features you’ll encounter; application changes; and new security improvements. 

Pricing and Availability

If you want to lay your paws on Mountain Lion, you’ll need to get it directly from Apple’s Mac App Store. The 
company’s newest operating system costs $20; you need to be running Snow Leopard on your Mountain Lion-
compatible Mac to begin the installation process. Like Lion, Apple will let you pay for and download one copy of 
Mountain Lion that you can install to multiple Macs—a welcome feature for multi-Mac households. (Unlike Lion, 
you won’t be able to get Mountain Lion via USB drive at the Apple Store.)

For those who purchased a Mac after June 11, you’re eligible to get Mountain Lion gratis.

Can I Install Mountain Lion on My Computer?

Here’s the official list of models Mountain Lion supports, according to Apple:

> iMac: mid-2007 or newer

> MacBook: late 2008 aluminum, or early 2009 and later

> MacBook Air: late 2008 or newer

> MacBook Pro: mid/late 2007 or newer

> Mac mini: early 2009 or newer

> Mac Pro: early 2008 or newer

> Xserve: Apple’s current specs page omits the Xserve line. However, that omission may be more a reflection of 
Apple’s loss of interest in the now-retired Xserve than of that machine’s ability to run Mountain Lion.

Buying Mountain Lion from the Mac App Store is as simple as any other app transaction: You just click the Buy 
button to begin the download. The update is several gigabytes, so you’ll want to make sure your Internet con-
nection that can handle with that kind of download. 

You can burn the downloaded installer to a CD or put it on a flash drive if you need to run it on other Macs; 
or you can run it directly from the Mac you downloaded it to. As with any applications you purchase from the 
Mac App Store, you can install Mountain Lion on any Macs that are authorized with the Apple ID you used to 
purchase the OS. That means that if your family has multiple Macs, a single $20 payment will let you install 
Mountain Lion on every machine. 

http://www.apple.com/osx/uptodate/
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Read more about installing OS X in the “Install Mountain Lion” chapter.

Accessibility

Lion made a few strides forward in adding accessibility features to the Mac, but Mountain Lion takes it much 
further: The Accessibility pane is now simpler to use, with a new keyboard shortcut (Command-Option-F5) for 
invoking it. OS X also adds support for 14 new braille displays, and includes a whole host of new things you can 
do with VoiceOver, the voice-driven assistant for those who have trouble seeing. 

VOICE COMMANDS VoiceOver gains a key command and a new interface, among many 
other additions 

VoiceOver now lets you drag and drop via modifier keys, reorder tables by column headers, and drag items to 
hotspots; you can also simulate the mouse’s press and hold buttons.

App Improvements

Several of Apple’s apps got the Mountain Lion treatment, with new features, visuals, and more, while others are 
new to the Mac entirely. iChat, Address Book, and iCal have been replaced with Messages, Contacts, and Cal-
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endars; Reminders, Notes, and Game Center are brand new; Mail, Preview, and Safari receive major improve-
ments; and QuickTime X, Photo Booth, and TextEdit get minor tweaks, such as H.264 encoding for QuickTime, 
the ability to set a Photo Booth image as your Twitter profile picture, and a pinch-to-zoom capability in TextEdit.

SAVED BY THE CLOUD Rename, move, duplicate, lock, and revert your documents, all 
from the title bar 

When it comes to features within apps, Lion’s Auto Save received a modest upgrade in Mountain Lion: You can 
now rename your file from a compatible app’s title bar without leaving the app; move the file to iCloud or else-
where; and revert it to the last saved version. When you close a document, the app should also prompt you to 
keep or discard all the changes you’ve made in that session. 

And when you start a new untitled document, it’s automatically stored in iCloud until you tell your Mac where 
else to store it. 

Save As devotees will be happy to see that it’s returned to the File menu with the keyboard shortcut Command-
Shift-Option-S. Duplicate also gains the keyboard command Command-Shift-S.

In addition, if you’ve enjoyed using AirPlay Mirroring on your iOS devices, you’ll now be able to do so on your 
Mac.

Read more about apps in the “App Improvements” chapter.

Automatic Updates

In Mountain Lion, the Software Update utility is no more: Instead, the Mac App Store holds all your system and 
software updates. 
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SOFTWARE CHECK Any system updates will appear in the Mac App Store Updates pane 

When you need to install a patch or an improvement, you’ll receive an alert that there are updates available. 
Click through, and you can install it right away—the Mac App Store does the downloading in the background so 
that you don’t have to wait.

Read more about the Mac App Store in the “Under the Hood” chapter.

Dictation

Systemwide dictation is at your fingertips with just a couple of key presses, thanks to Mountain Lion’s new dicta-
tion integration. The feature works anywhere there’s a text field; just tap the function key twice to enable it, and 
then speak into your built-in microphone.

DICTATE TO ME Enable Dictation by tapping the function key twice; to dictate, just tap it 
again within a text field 

Dictation is intelligent—it learns your accent the more you speak, and it can recognize when you’re saying the 
name of your friend; you don’t have to worry about “Lex Friedman” being turned into “Let’s cheese, man.” The 
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feature currently supports English (U.S., U.K., and Australia), French, German, and Japanese.

Read more about dictation in the “Under the Hood” chapter.

iCloud

When it comes to online sync, Mountain Lion and iCloud are a matched pair. The OS X update brings enhanced 
support for sync, adding Notes, Reminders, and Game Center into the mix; Mountain Lion integrates this fea-
ture at the system level, letting you add an iCloud account when you set up your computer.

DOCUMENT DISPATCH Documents in the Cloud offers discrete Document libraries for 
each app where you can create (and add) files and folders 

iCloud’s new features include Documents in the Cloud for supported apps, a custom synced user dictionary, 
and synced tabs and windows in Safari for all your devices.

Read more about iCloud in our “Under the Hood” chapter.
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Notification Center

Like the iOS feature of the same name, Notification Center holds alerts and banners for apps you’ve allowed to 
notify you. When an app wants to alert you, it sends a banner or alert, which floats up in the right corner of the 
screen. Click the banner to go to the app; if it’s an alert, you can either dismiss it or go to the app. 

Click the new three-line icon in the upper right corner of the screen (or perform a two-finger swipe from the 
right edge of your trackpad) to reveal Notification Center, which holds all your past notifications.

NOTIFICATION ORGANIZATION A Notifications pane in System Preferences allows you 
to reorganize your apps and choose what kinds of notifications they provide (if any) 

Inside is a list of notifications, along with a field for directly tweeting to Twitter (in the fall, you’ll be able to post 
a status update to Facebook, as wel). You can also turn banners or alerts on and off, and access Notification 
Center’s preference pane.

Read more about Notification Center in our “Under the Hood” chapter.
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Security

Sandboxing—which limits apps to requesting only the system processes it needs to run—was the security 
watch-word in Lion. For Mountain Lion, it’s all about Gatekeeper. The new security feature lets you choose 
the kind of apps you want to download for your computer: You can opt to download only apps from the Mac 
App Store; apps from Mac developers who have registered using Apple’s Developer ID program; or any and all 
apps—even if they might contain malicious code. By default, the middle option is selected, but you can always 
change that in System Preferences.

THE GATEKEEPER Choose what kinds of apps you’d like to be able to download and open 
on your system 

Other new security features include new management tools for FileVault, daily software-update checks by 
Mountain Lion, safe HTML handling within Safari, FIPS 140-2 encryption, and Kernel ASLR.

Read more about security in the “Meet Gatekeeper” chapter.

Sharing

Mountain Lion just loves to let you share: A new Share button has been added to applicable Apple apps, Quick 
Look, and the Finder, allowing you to send files, images, documents, locations, links, and more to your friends 
and family. You can share to Twitter, Vimeo, Flickr, AirDrop, email, Messages, AirDrop, and (in the fall) Facebook.
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SHARED EXPERIENCE All applicable apps now have Share buttons with adaptive options, 
depending on what program you’re using 

Notification Center will also sport status-update fields for Twitter (and later on, Facebook).

Read more about sharing in the “Under the Hood” chapter.

System Improvements

The Finder in Mountain Lion gains a few small changes: You can now view the progress bar of a copied file and 
cancel a copy in the Finder window; encrypt a drive by Control-clicking on it; and share files via the new built-in 
Share button. Additionally, sidebar categories in Finder windows can now be reorganized, and you can preview 
a file by hovering over it and using a three-finger tap gesture on your trackpad.

Meanwhile, Dashboard and Launchpad may not be the Mac OS’s most-loved utilities, but both get minor 
updates in Mountain Lion: Dashboard gets a new widget browser, widget search, and iOS-like widget-folder 
creation, while Launchpad receives its own search field to help find your apps.

FOLDED UP Dashboard now allows you to create folders and reorganize your widgets, 
iOS-style 
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Macs with solid-state drives receive a new Mountain Lion feature called Power Nap: While your Mac sleeps, it 
will still continue to sync your mail, notes, reminders, messages, calendars, and apps, as well as back up your 
machine, so that you don’t have to wait for everything to refresh on wake-up. 

There are a few other system improvements hidden in Mountain Lion, too. Apple has made a few tweaks to the 
Dictionary app: You can now swipe between pages and access Simplified Chinese, Spanish, and German diction-
aries). You can also choose to go full-screen on your main or secondary display, though you still won’t be able to 
access the other while in full-screen mode. And when screen sharing, you can now drag and drop files from the 
remote Mac to your desktop.

Time Machine, Apple’s backup utility, gains the ability to create encrypted backups and offers backup for mul-
tiple locations.

ENCRYPTED CAPSULE You can now encrypt your Time Machine backups 

Mountain Lion also sports more features for Chinese users, including improved text input for Simplified Chi-
nese and Traditional Chinese; dynamic word lists; support for Fuzzy Pinyin input and autocorrection; better 
handwriting recognition for Chinese characters; support for mixed Chinese/English sentences and emoji; the 
addition of the Standard Dictionary of Contemporary Chinese and the three-finger tap gesture to define  Chinese 
words; support for Sina Weibo, Youku, and Tudou video upload; Baidu search in Safari; and eight new Chinese 
fonts.

Read more about system improvements in the “Under the Hood” chapter.
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Install  
Mountain Lion

INSTALL THE CAT Ready to install Mountain Lion? Here’s our guide 

Last year, Apple dramatically changed the way we get and install OS X. Instead of charging a princely sum for an 
installation DVD, the company let you download OS X 10.7 (Lion)—specifically, the OS installer—from the Mac 
App Store, and charged only $30 for the privilege. This new process was a success for most users, and Apple is 
using it again for Mountain Lion (OS X 10.8). Except that this time around, the update is even less expensive: just 
$20. But as simple as the process is, we offer some tips for making it go as smoothly as possible.

C H A P T E R  2
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It’s prudent to note that Mountain Lion is brand new, so although it could be bug-free, chances are it isn’t—we 
usually see the first update for new OS X versions within a few weeks of the initial release. If downtime is not an 
option for you, you might consider holding off for the inevitable OS X 10.8.1.

DO YOU QUALIFY?
Before you download and install Mountain Lion, a few quick tasks are in order. First, you should make sure Mountain 
Lion is compatible with your particular Mac. According to Apple, to run Mountain Lion, you must have one of the follow-
ing models, and it must already be running either OS X 10.6.8 or any version of OS X 10.7:

> iMac: mid-2007 or newer

> MacBook: late 2008 aluminum, or early 2009 and newer

> MacBook Air: late 2008 or newer

> MacBook Pro: mid/late 2007 or newer

> Mac mini: early 2009 or newer

> Mac Pro: early 2008 or newer

> Xserve: early 2009

(Note that while the above models can run Mountain Lion, some of the new OS’s features, such as Power Nap, AirPlay 
mirroring, and AirDrop, have stricter requirements. Apple provides more information on its “OS X Mountain Lion Tech-
nical Specifications” webpage.

Apple also says you need 2GB of RAM (memory), although in our testing, you’ll have a better experience with at least 
4GB—you might consider a hardware upgrade before installing OS X 10.8. Similarly, Apple recommends having at least 
8GB of free space on your Mac’s drive, but we recommend playing it safe by aiming for 15GB or more. If you need to 
free up space, you can use a utility such as WhatSize or GrandPerspective to help you find big files you can get rid of; 
we’ve also provided some specific suggestions on our website. Not sure which Mac you own or how much RAM or 
free drive space it has? Choose About This Mac from the Apple menu, and then click More Info. In Lion, the resulting 
window displays your computer model and OS version. Click the Storage tab to view your drive’s free space, and click 
Memory to check its RAM capacity.

http://www.apple.com/osx/specs/
http://www.apple.com/osx/specs/
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Before You Install
Assuming your Mac qualifies for Mountain Lion, the next step is to get it ready. First, make sure your drive is 
healthy: Open Disk Utility (in /Application/Utilities), select your startup drive on the left, and then click the Verify 
Disk button. If Disk Utility finds problems, you’ll need to boot from a different volume—an older OS-install disc, 
a bootable hard drive, or, if you’re running Lion, Lion Recovery—to perform the actual repairs (using Disk Util-
ity’s Repair Disk button).

You should also make sure you’ve got a recent backup—using Time Machine or a third-party backup utility—
and you should test that backup to make sure it’s working. To test your backup, try restoring a few recent files, 
or, if you’ve got a clone (mirror-image), try booting from that clone.

If you’re upgrading from Snow Leopard and you have FileVault enabled on any of your Mac’s accounts, you 
should disable FileVault before upgrading to Mountain Lion. Lion and Mountain Lion use a new (better) ap-
proach to encryption, and it’s safer to upgrade from non-encrypted accounts. (If you’re upgrading from Lion 
and you’re using FileVault 2, you’re fine.) Similarly, if you’re using third-party disk encryption, you should prob-
ably disable that before installing Lion.

Next, use Software Update to make sure you’ve got the latest versions of your Apple software—Apple some-
times releases OS updates that improve the process of upgrading from one OS version to another, and some 
Apple apps must be updated before they can support new OS features. You should also check for any firmware 
updates for your particular Mac model. Finally, you should spend some time checking the websites of your fa-
vorite third-party applications to see if any of them need to be updated to work with Mountain Lion—checking 
compatibility before installing Mountain Lion means you’ll be able to get up and running immediately. (For Mac 
App Store apps, just launch the App Store app, click the Updates button in the toolbar, and you can update all 
your Mac App Store–purchased software with a click.)

Get the Installer
To get the Mountain Lion installer for the first time, simply launch the Mac App Store, click the Mountain Lion 
banner on the store’s main page (or search for Mountain Lion), and then click the price button to the right, and 
then click the Buy App button. After providing your Apple ID and password, Mountain Lion will begin download-
ing. The installer, called Install OS X Mountain Lion.app, will be saved to your main Applications folder (/Applica-
tions).

TIP: UPGRADE FOR FREE
If you recently purchased a new Mac and it didn’t ship with Mountain Lion, you may be entitled to a free copy. Check to 
see if you qualify.

http://support.apple.com/kb/HT1237
http://support.apple.com/kb/HT1237
http://www.apple.com/osx/uptodate/
http://www.apple.com/osx/uptodate/
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Before proceeding to the next step, note: If you run the installer from its default location in the Applications 
folder, the installation process deletes the installer. So if you plan to install OS X 10.8 on other Macs—your pur-
chase entitles you to use Mountain Lion on any eligible Macs you own—or if you just want to keep the installer 
on hand, before installing you should either move it to a different location on your hard drive or copy it to a 
different drive. (You can download the installer to another of your Macs by clicking the Purchases button in the 
App Store app on that Mac and then clicking Download for the Mountain Lion installer, but it’s a lot easier—and 
faster—to just copy the installer from one Mac to another.)

Install the OS
Like the Lion installer, the Mountain Lion version offers few options: Other than choosing where to install the 
OS, you don’t need to make any decisions until it’s time to set things up and start using your Mac. You don’t 
even need to boot from a different disc or volume—the Mountain Lion installer, like its Lion counterpart, runs 
as a standard application.

INSTALL ME If you have multiple disks, you must choose which one you want to install 
Mountain Lion on 
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Double-click the Install OS X Mountain Lion application, and click Continue on the initial screen to begin the 
installation process. After agreeing to the software license agreement, you see a screen with your startup drive. 
If you want to install the OS on that drive, click Install; to install it on another connected drive, click the Show 
All Disks button, choose the desired drive, and click Install. (You can choose any drive with OS X 10.6.8 or later 
or any blank drive; the drive must also be formatted as Mac OS Extended [Journaled] and use a GUID Partition 
Table. The built-in drive on any Mac eligible to run Mountain Lion should meet these requirements.) Type your 
administrator username and password to proceed.

The installer will spend a few minutes preparing the installation, and it will then quit any open apps and restart 
your Mac. After your Mac restarts, the actual installation occurs. Based on our testing, the process generally 
takes somewhere between 15 and 25 minutes, after which your Mac will restart and boot into Mountain Lion.

When installation finishes, what you’ll see depends on whether you’ve installed the OS on a blank drive or on 
a drive containing Snow Leopard or Lion. When you install Mountain Lion over Lion, your Mac boots normally; 
once you log in, you can start using it immediately. You may see a message about incompatible software de-
tected during the installation. If so, you should check with the software vendor to see if an updated version is 
available.

INCOMPATIBILITIES The Mountain Lion installer will move—and alert you about—low-
level software that it knows is incompatible with OS X 10.8.
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If you upgraded from Snow Leopard, the first thing you see will be a screen asking for your Apple ID or, if you 
don’t have one, to create one. After agreeing to the Apple ID terms and conditions, you’ll be given the option to 
set up iCloud, and then you can log in and start using your Mac.

If you installed onto a blank drive, you’ll be greeted with the initial Mountain Lion welcome and setup screens. 
You’ll then be asked if you want to transfer accounts and data from another computer or drive (which includes 
a Time Machine backup). After that, you’ll be asked to enable Location Services (to allow apps to determine your 
geographic location),  and to enter your Apple ID or, if you don’t have one, to create one. After agreeing to the 
Apple ID terms and conditions, you’ll be given the option to set up iCloud, and then, if you didn’t transfer ac-
counts from another computer or drive, you’ll need to create a user account. Finally, you’ll be asked to set your 
time zone, and, optionally, to register your Mac to your Apple ID. You’re then logged in to your account.

Post-Install
Besides checking for updates to incompatible software, there are a few other tasks you should perform post-
install. An important one is to use the Mac App Store to check for new Apple-supplied updates. For example, 
some older MacBook Air models require a firmware update that enables the new Power Nap feature, and that 
firmware update doesn’t appear in the Mac App Store until after Mountain Lion is installed. (Unlike previous 
versions of OS X, which used Software Update to check for and install updates, Mountain Lion uses the Mac App 
Store, letting you update both the OS and applications at once.)

FIX BARRIERS When you upgrade, location and sharing services may be turned off  You 
can fix this in System Preferences 
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You should also check your Sharing settings (in the Sharing pane in System Preferences) and Location Services 
settings (in the Privacy tab of the Security pane). Sharing and Location Services by default are automatically 
disabled after you install Mountain Lion over Lion. You may want to enable some sharing options, and you’ll 
want Location Services enabled if you use Find My Mac. If you upgraded from Snow Leopard, you may need to 
configure your printers in the Print & Scan pane in System Preferences.

If you installed Mountain Lion onto a blank drive, you need to set up your applications and settings. Even if you 
migrated applications, documents, and settings from another Mac or a backup, chances are there may be a few 
registration numbers to enter and settings to configure.

If you want to use FileVault, OS X’s disk-encryption feature, but it’s not enabled—either because you’ve never 
used it or because you upgraded from Snow Leopard and followed the above advice to disable it before up-
grading—now’s the time to turn it on, via the Security system preferences.

Most users can complete this entire process in less than an hour, which is a far cry from the days of multiple-
hour clean installs and complicated setup procedures. And assuming all goes well, you should be up and run-
ning, and enjoying Mountain Lion’s new features, right away.
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PEEK UNDER THE HOOD What’s new in Mountain Lion’s system? Let’s take a look 

The biggest changes to Apple’s Mac operating system this go-around happened not in apps, but in lower-level 
system features. Mountain Lion boasts improved iCloud functionality, the addition of notifications and iOS’s 
Notification Center, new sharing options, Dictation features, and—for Macs equipped with a solid-state drive 
(SSD)—PowerNap, a way to continue syncing and retrieving your information while your Mac is asleep. In this 
chapter, we take a look at the new and improved options under your Mac’s hood.

C H A P T E R  3
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iCloud
When Apple introduced iCloud—its fourth attempt to create an online service for its users—in 2011, it touted 
the new service’s ability to sync data seamlessly from all of your Apple devices. Unfortunately, iCloud didn’t im-
mediately deliver on those promises.

WELCOME TO iCLOUD The iCloud preference pane is similar to Lion’s, but adds full 
support for Documents & Data syncing 

iOS 5 took early advantage of iCloud, but on the Mac, we only got limited integration in OS X Lion: You could 
sync your mail, contacts, calendars, reminders, and notes, and send images to your iPhoto library via Photo 
Stream, but you couldn’t sync documents or program settings. With Mountain Lion, however, Apple has taken 
iCloud integration several steps forward.

Living in the iCloud

When you buy a new computer with Mountain Lion, you’ll be prompted to add or create your iCloud account. If 
you add an existing account, Mountain Lion automatically downloads your synced iCloud information to your 
computer; if you have applications that sync with iCloud, it brings over all your data from those apps, too. If 
you’ve never used iCloud, Apple makes it easy to sign up for a free account.
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iCloud’s original sync options—mail, calendars, and contacts—get a few nice boosts in Mountain Lion. With the 
addition of Reminders and Notes as apps in Mountain Lion, your iOS- or Mac-created tasks or snippets sync di-
rectly to those programs, rather than through Calendars and Mail. Speaking of Mail, iCloud syncs a bit more of 
your data now: recent senders, favorites, signatures, flag names, smart mailboxes and mail rules (though most 
of these are across OS X computers only, and don’t sync with your iOS devices), and your account information.

Documents in the Cloud

Apple’s Documents in the Cloud feature may be the biggest addition to Mountain Lion. That system-wide ser-
vice allows the app you’re using to store your documents wirelessly and remotely on your iCloud account; you 
can then access those documents from any computer or iOS device you’ve linked to iCloud that has the same 
application installed.

DOCUMENT CACHE Each iCloud-enabled app has its own document storage area 

Unlike the traditional Finder, which holds files for all your apps, iCloud provides each app with its own Docu-
ment library; there’s no master documents list of all your various stored documents, which could cause some 
confusion if, say, you want to open the same remotely stored file in multiple text-editing programs. 

Open a file in an iCloud-supported app, and the Document library window pops up. It looks similar to the 
template selection window in apps such as Pages: a single-pane window with a list of files against a linen back-
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ground. Files appear as icons (in Icon view) or in a list (in List view). In Icon view, you can organize files by name 
or date; List view offers categorization by name, size, or date. Along the top of the window, there’s a search bar 
(in case your list of files grows unwieldy) and a toggle to switch the Open command back to those files located 
on your Mac.

If you’ve never used the app before, the library will be empty; you can populate it by dragging files from your 
Mac or from the Document library of another application (if the files are cross-compatible).

MOVING TIME You can drag files from one program’s iCloud Document library to 
another’s, or from the desktop to an iCloud Document library 

By default, when you drag a file from one library to another, that actually moves the file to the new library rath-
er than duplicating it—it’s similar to moving a file to a different folder on your hard drive. You can force iCloud 
to duplicate the file, however, by holding down the Option key when you drag it into or out of an app’s Docu-
ment library; the duplicate appears with a number appended to the name of the file. (You can also duplicate 
a file within a library by holding down the Option key, dragging it out, then dragging it back into the window; 
alternatively, you can Control-click [right-click] on the document and select Duplicate.)

If you like a well-organized set of files, you can accomplish this iOS style, by dragging icons on top of one 
another to create a folder. But if you’re a Finder power user, you’ll be disappointed to learn that you can’t nest 
folders in the Document library. You can drag folders from a Document library to the Finder to move them to 
the desktop, or drag them to another Document library, just as you would drag a file.
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FOLDED FOLDERS Drop a file on top of another file to create a new folder containing 
both files 

To open a file, you just double-click it, which should seem routine to a Mac user. Files stored in iCloud offer the 
added benefit of having their full version history available, so you can use Auto Save, restore past versions of 
your files, and duplicate them with ease.

Back in the Document library, you can share files by selecting them and clicking the Share button, or by Control-
clicking (or right-clicking) the file. Though you can’t share folders, you can select multiple files; not all sharing 
services support sending more than one file, however. Twitter, for example, only lets you share one picture at a 
time.

If you no longer want a file, you can move it to the Trash by dragging it there or Control-clicking (or right-click-
ing) it, which brings up a Trash option.. This removes the file from iCloud, and your devices can no longer access 
it there.
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TO THE TRASH Delete an iCloud document and it drops itself in the Trash on your Mac 

Currently, Apple’s TextEdit and Preview support Documents in the Cloud, and support for the iWork suite is 
coming soon. Third-party developers who sell their apps through the Mac or iOS App Store can also integrate 
Documents in the Cloud into their apps; developers who sell outside the App Store will be left out, unfortu-
nately.

Syncing Safari

Safari also takes advantage of a new iCloud feature: synced tabs. This allows you to start browsing the Web on 
your iPhone and immediately pick up where you left off on your Mac.

Macs running Mountain Lion have a Cloud icon in the Safari toolbar; click it to see a list of your iCloud-enabled 
devices, with any open Safari tabs or windows below their names.

Unfortunately, you can’t manually refresh this list, so you have to wait for iCloud to catch up and sync if you’ve 
just opened a new tab on a particular device; that said, in our preliminary testing, the process was usually fairly 
quick, at most taking no more than a minute or so.

Notifications and Notification Center
iOS users will immediately recognize Mountain Lion’s new notification system: It’s more or less the same as 
the one that debuted on iOS 5 last year. Longtime Mac users, on the other hand, will probably recognize its 
functionality as similar to what the open-source framework Growl offers. In either case, the idea is simple: Lots 
of things happen on your Mac—emails, IMs, alarms, even Twitter updates. Notification Center alerts you when 
they happen and gathers all of those alerts in a single location, so you can see at a glance everything that’s been 
going on. 
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MEET NOTIFICATION CENTER OS X’s new notification system, Notification Center, 
appears along the right side of your screen 

Like its iOS counterpart, OS X’s notification system actually has two parts. The first is Notification Center itself, a 
repository of all the notifications you’ve received. To activate Notification Center, just click on the Notifications 
icon in the top right corner of the menu bar, or swipe with two fingers from the right edge of your trackpad 
toward the middle. (Your fingers actually have to start to the right of the trackpad itself, and then slide onto it.) 
This works at any time, even when you’re in a full-screen app. To hide Notification Center again, reverse your 
swipe, or click the menu-bar icon a second time. 

Clicking any notification in Notification Center launches the appropriate app and, when possible, takes you to 
exactly the data that triggered the alert (the relevant message, event, and so on). Unread notifications appear 
with a blue dot next to them, which disappears when you click them. You can also mark all notifications for a 
single app as read by clicking the X icon in the top right corner. Note that you can’t clear individual messages; 
also, some apps—such as Calendar—have persistent notifications that you can’t dismiss.

Alerts and Banners

Of course, you’re not always looking at Notification Center—it’s often tucked away. The second part of Moun-
tain Lion’s notifications are alerts and banners, which an application triggers when it wants to pass some infor-
mation along to you. 
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BANNER UP Though both alerts and banners appear in the top right of your screen as 
floating boxes, alerts are persistent, hanging out until you dismiss them 

While both alerts and banners take the form of small boxes that appear in the top right corner of your screen, 
they differ in one way: Left alone, banners disappear a few seconds after they arrive; you have to dismiss alerts 
manually. Most alerts also have a Snooze button, which suspends the alert for 15 minutes, and some have other 
options. The Mac App Store, for example, prompts you when updates for apps—or even for OS X—are avail-
able, giving you the option to view the details or click to update right there and then. 

Sometimes you want to silence all your alerts for a while—if you’re watching a movie on your computer, for 
example. To do so, scroll the window down until you expose the Show Alerts And Banners slider. Switch that to 
Off, and it suppresses your alerts and banners until you reactivate them; if you forget to turn the switch on, it 
automatically reactivates in 24 hours, so you don’t accidentally miss all your messages. Even better, Mountain 
Lion automatically disables alerts and banners when you’re making a presentation in Keynote, or when your 
display is mirrored to an external monitor.

Customize Notification Center

You can have Notification Center organize your notifications in one of two ways: manually or by time. In the 
default manual scheme, open the Notifications pane in System Preferences and drag the apps and services in 
the left column into whatever order you desire. 
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PREFERENTIAL TREATMENT In the Notifications preference pane, you can determine 
how you’d like your notifications displayed 

If you prefer to organize notifications by time, which you can do via a drop-down menu at the bottom of the 
pane, you instead see the most recent arrivals at the top. For each app, you can choose to see 1, 5, 10, or 20 of 
the most recent items, as well as decide whether the app should send banner or alert notifications (or none at 
all), whether its icon should appear with a badge for unread messages, and whether a sound should play. 

Some of the entries in the Notifications pane have additional options. For example, if you’ve entered your Twit-
ter account in the Mail, Contacts & Calendar pane, you can set whether you want notifications for mentions, di-
rect messages, both, or neither. And you can enable and disable the Sharing widget, which lets you send posts 
from Twitter (and, later this year, from Facebook) right in Notification Center.

If you don’t want an app to appear in Notification Center, you could just uncheck all the boxes and set the alert 
style to None. But it’s far easier to click the entry in the Notification preference pane’s left column, and drag it 
down until it’s under the Not In Notification Center section; that way, you won’t see any notifications from it 
whatsoever.

While Apple has updated its apps to work with Notifications, third-party developers will have to update their 
apps to work with the system—and Apple has limited access to only those apps in the Mac App Store. Fortu-
nately, the developers of Growl—which itself has now transmuted into a Mac App Store app—have already 
pledged compatibility with Notification Center, so that should allow those non–App Store apps to send notifica-
tions.
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App-Specific Options

Certain apps take some settings for notifications into their own hands. Mail, for example, features a pop-up 
menu in the General pane of its Preferences menu, which lets you choose to receive notifications only for new 
messages in your inbox, only for messages from people you’ve selected as VIPs, only for messages from your 
contacts, or for messages in either all your mailboxes or a selected smart mailbox. Sadly, some apps don’t offer 
this much-needed granularity—Calendar, for example, lets you turn off shared calendar messages and/or invi-
tations in Notification Center, but doesn’t let you restrict notifications to certain calendars. 

UNIQUE NOTIFIERS Safari allows certain websites, including Gmail, to deliver 
notifications via Notification Center 

Safari is in a category of its own, since it can actually pass along notifications from certain websites to Notifica-
tion Center. How those notifications appear is dictated by how you configure Safari in the Notifications prefer-
ence pane, but within Safari’s own Preferences, you can allow or deny notifications on a per-site basis. Only a 
few sites support this right now, such as Gmail and Facebook, but that number will likely increase. 

Sharing
One of the many features that Mountain Lion has borrowed from iOS is the idea of system-wide sharing. In 
many apps you’ll see a Share button—represented by an arrow popping out of a box—which provides quick 
one-button access to several ways you can share the content you’re viewing. So, for example, where you might 
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once have had to—heaven forfend!—copy and paste a URL you wanted to share with your Twitter followers, 
now you can share that link right from where you found it. 

SHARED MOMENTS Use the new Share button in Mountain Lion to send files to your 
friends and family with a single click 

By default, Mountain Lion lets you share via OS X’s built-in communications apps, including Mail and Messages. 
But Sharing is extensible in a couple of different ways. For instance, if you go to the Mail, Contacts & Calendars 
pane in System Preferences and add the details for your accounts with popular services such as Twitter, Flickr, 
Vimeo, and (later this year) Facebook, those accounts will then be available as options in the Share menu. 
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SHARING ACCOUNTS Add your various accounts in the Mail, Contacts & Calendars 
preference pane 

By adding an account in that preference pane, you ensure that you only have to enter your credentials once, 
rather than every single time you want to share a file. You can even enter multiple accounts for some services, 
such as Twitter, and pick the account you want to use for sharing on a per-post basis.

What happens when you choose Share varies depending on the service you’re using and the kind of file you’re 
sharing. If, say, you’re posting to Twitter or Facebook, you see a sheet that lets you fill in your post, along with a 
button that lets you add your location. 
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CLIPPED When you share a file, it “clips” itself to a Share sheet for you to send 

When adding photos to Flickr or videos to Vimeo, you can add a title, description, and tags, and choose who 
can view those posts. Mountain Lion also provides a handy visual cue that shows the files or information you’re 
sharing—it attaches a thumbnail of the content to the Share sheet with a virtual paper clip. 

App Variations

When you share something via email, Mail launches and presents you with an email message, prepopulated 
with the content you’re sharing. If that content is a file, it’s attached to the message, but if it’s a webpage from 
Safari, you get a drop-down menu with options to share it in Safari Reader view, as a webpage archive, as a PDF, 
or simply as a link.
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VARIATIONS ON SHARING Certain apps, like Safari, have their own sharing options 

Certain applications also have their own sharing options. For example, in Safari, you can add a page to your 
reading list or to your bookmarks. The Finder, Preview, and Quick Look also allow you to send a file to AirDrop, 
the inter-Mac sharing feature introduced in Lion, or to iPhoto or Aperture if it’s an image. To that, Photo Booth 
adds the ability to set an image as your user account picture or Twitter profile picture. Contacts lets you share 
contact information via Mail, Messages, or AirDrop; the Mac App Store lets you share an app via Twitter or Mes-
sages. 

You don’t always have to share items via the Share button, either—the Finder lets you do so by Control-clicking 
(or right-clicking) on a file and choosing Share from the contextual menu. You can do the same thing in Safari by 
Control-clicking on the location bar. 

Twitter users can also use Mountain Lion’s Sharing features to post directly to that service, without a third-party 
client. Just activate Notification Center with a two-finger left swipe from the right edge of your trackpad, or by 
clicking the Notification Center icon in the top right corner of the menu bar. At the top of the list of notifications 
is an embossed button for Twitter; click it to see a Share sheet for that service. Once Apple adds Facebook inte-
gration later this year, you’ll be able to use the same feature to post to that service.

Dictation
Though it falls short of integrating Apple’s iOS assistant, Siri, Mountain Lion’s system-wide support for dictation 
brings the company’s mobile OS transcription functionality to the Mac. Anywhere you can type text on your 
Mac—in text editors, Web browser form fields, email messages, and so on—Mountain Lion lets you dictate it as 
well. 
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DICTATION TIME Tap the Fn key twice when the cursor is in a text field to start dictating 
your message 

On iOS, the on-screen virtual keyboard includes a little microphone key to trigger the Dictation app. Since your 
Mac can’t update its hardware keyboard dynamically, Mountain Lion instead requires a keyboard shortcut to 
enter Dictation mode.

The default keyboard shortcut for starting Dictation is to tap the Fn key twice with the cursor in a text field. But 
you can customize the shortcut if you head over to the Dictation & Speech preference pane. (Before Mountain 
Lion, Apple called that pane Speech.) You’ll also find a new Start Dictation option near the bottom of the Edit 
menu. 
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THE DICTATION MACHINE Adjust the keyboard shortcut and enable or disable Dictation 
in the Dictation & Speech preference pane 

In the Dictation tab, you can turn the functionality on or off, tweak its shortcut, switch to the microphone you 
want to use, and adjust the language you’ll be speaking. That last detail understandably impacts the way the 
software transcribes the words you say. Supported languages include English (for the United States, United 
Kingdom, and Australia), French, German, and Japanese.

When you adjust the keyboard shortcut, Apple includes a few suggestions of its own: In addition to the default 
double-tap of the Fn key, you can choose a double-press of the left Command key, right Command key, or 
either Command key to trigger Dictation. If you prefer to select your own keyboard shortcut, you can do that, 
too—but you can only create traditional keyboard shortcuts (like, say, Command-Shift-Option-D), not any that 
require a double-tap on a key.

Whatever keyboard shortcut you choose, your Mac will be ready to listen almost immediately after you press it. 
A microphone appears on your screen near the insertion point; the mic lights up to reflect the current volume. 
To capture your every word as precisely as possible, Mountain Lion automatically pauses iTunes and stops your 
laptop’s fans to create as quiet an environment as it can, and keeps them quiet until you’re finished dictating.

Dictation doesn’t transcribe word by word as you speak; rather, it waits until you’re all done. When you’re 
finished talking, press your chosen keyboard shortcut again, press Return, or click the Done button next to the 
Dictation microphone. If you instead press the spacebar or another key, however, Mountain Lion loses any 
memory of what you just dictated faster than you can say “Whoops.”
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As Mountain Lion processes what you’ve dictated, you’ll see some animated purple dots. The moment your 
transcription is ready, your dictated text replaces those dots. 

THE PROCESS After you’ve finished dictating, Apple uploads your speech to its servers to 
translate it into words and punctuation 

Your Mac doesn’t actually do the heavy duty of converting your speech into text; as with dictation on the 
iPhone, Apple servers located elsewhere handle that chore. For that reason, Mountain Lion’s version of the fea-
ture works only when you have an active Internet connection. Apple also requests your permission to upload 
certain bits of your data to its servers—notably, the first and last names of the folks in your Mac’s Contacts—so 
that it can better transcribe what you say. Without access to our address book here at Macworld, for example, 
Dictation is inclined to transcribe Lex Friedman’s last name as “Freedman” and Dan Moren’s as “Moran.” If you 
opt to share your data with Apple, Dictation should handle even complicated names with ease.

Dictation Punctuation

As on iOS, Dictation on Mountain Lion supports a variety of vocal cues. For instance, you’ll need to get comfort-
able speaking your punctuation—the software can’t infer where your periods, commas, and so forth should go. 
Instead comma get used to speaking like this period.

You can use numerous other Dictation shortcuts as well. Common phrases to commit to memory include new 
paragraph, new line, and quote unquote. You can also speak the names of various symbols, like dollar sign, as-
terisk, and smiley, winky, or frowny face. Mountain Lion’s Dictation feature doesn’t support some other cues that 
iOS’s does, like all caps on, all caps off, and cap for capitalizing individual words.

While you don’t need to train Dictation manually, Apple says that it can improve its accuracy in transcribing 
your particular voice over time. If Dictation isn’t certain that it properly transcribed specific words or phrases, it 
underlines them in blue; Control- or right-click them to see alternate transcription suggestions. Dictation may 
not catch and underline all of its transcription errors, though, so you’ll always want to read back over your tran-
scriptions carefully.
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Of course, the big question is how well Dictation works. In our testing, it performed quite capably, but it’s far 
from flawless. While you can speak naturally, you’ll get better results from Dictation if you enunciate carefully, 
particularly on potentially homophonic words and phrases. Dictation is patient: You can take brief pauses to 
gather your thoughts, and the service keeps listening to you without shutting off. If you leave Dictation open for 
a really long time, it eventually stops itself and transcribes everything it heard. But in general, you have a good 
long time to speak, and pauses aren’t a problem. 

While Dictation may feel awkward at first, it can eventually become a powerful way to gather your thoughts 
and write text of varying lengths, in situations where using your keyboard would be difficult or unwieldy. And 
it works just like typing in a word processor—highlight text before you start dictating, and the transcription re-
places your selection; move the insertion point elsewhere in your document before you begin, and that’s where 
your transcribed text appears.

PowerNap
More than a few Mac users worry that OS X is becoming too much like iOS, as the former gains features—and 
even user-interface elements—obviously inspired by the latter. But even the most anti-iOS Mac user has to 
admit that sometimes this is a good thing, as some of those migrated features have unquestionably improved 
the Mac experience.

To whit: With our iPhones and iPads, we’ve come to expect that even when the device has been asleep, wak-
ing it immediately presents us with our latest email, events, reminders, changes to contacts, and more, which 
downloaded while the device was snoozing; these devices even back up to iCloud and sync with iTunes while 
they’re sleeping. Under Mountain Lion, if you’ve got a Mac laptop with a solid-state drive (SSD, also known as 
flash storage), you get many of the same benefits. (Some older Mac laptops need a firmware update to gain this 
functionality.)



42

C H A P T E R  3   Under the Hood

SLEEPY TIME PowerNap lets your computer sleep while it works 

You enable this new feature, called PowerNap, in the Energy Saver pane of System Preferences. Once you do, 
your laptop sleeps normally whenever you close the lid or use the Apple Menu’s Sleep command. But, assum-
ing the computer is connected to a power source or has sufficient battery charge, it periodically wakes itself to 
check for email, calendar events, notes, reminders, messages, contact updates, Photo Stream photos, changes 
to Documents in the Cloud, and communications from Find My Mac, downloading new data when necessary.

If your Mac is connected to a power source, PowerNap also checks for and downloads—but doesn’t install—
new updates to Apple software, including the OS itself; if you back up to a Time Capsule, your MacBook also 
updates its backups. Apple says that PowerNap is power efficient enough so it won’t significantly affect your 
MacBook’s battery life, and that your Mac’s screen and fan remain off during updates.

What this means is that whenever you wake your laptop, all your updated data is there, ready for use; any soft-
ware updates are ready for installation; and the system has updated your backups, so you can pack up and be 
on your way. In other words, Mountain Lion took a great feature from iOS and made it better on the Mac.



Work with Apps

THE WORLD IN APPS Launchpad is one of several app-related features that got 
additions and alterations in Mountain Lion 

Mountain Lion’s system features carry over to those programs and interfaces that interact with apps as well. 
The Finder has a few new tricks up its sleeve, Launchpad and Dashboard receive search bars and—in Dash-
board’s case—folder organization, the Mac App Store gains more functionality, Auto Save brings back the Save 
As command, and AirPlay mirroring comes to the Mac. This chapter details some of the smaller system features 
in Mountain Lion that relate to apps.

C H A P T E R  4
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Work with the Finder
The backbone of OS X, the Finder has received a few extra polishes in Mountain Lion. When you’re downloading 
a file or copying it from a server to your desktop, Mountain Lion displays a progress bar in the file’s Finder icon. 
It’s also possible to cancel copy jobs in progress.

VISUAL TRANSFER Watch your file progress from the Finder, and cancel by clicking the X 

The Finder’s sidebar is also now customizable: You can drag the various categories there (Favorite, Shared, and 
so on) into whatever order you wish. And you can now encrypt a drive from the Finder: Just select the drive and 
choose Encrypt from the contextual menu.

If you have an aversion to using the spacebar, you can trigger Quick Look with a three-finger tap on the track-
pad (as well as the old-fashioned spacebar way).

FINDER SHARE Click the new Share button to share your files and folders from the 
Finder 

And, of course, there’s that Share button that’s popping up all over Mountain Lion (its icon shows an arrow es-
caping from a box): Select a file, and then click on the Share button, and you can share files via email, Messages, 
AirDrop, Twitter, or Flickr, depending on what type of file you’ve selected.



C H A P T E R  4   Work with Apps

Quickly Alter Your Documents with Auto Save
Auto Save, introduced in OS X Lion, allowed you to browse previously saved versions of a document—much as 
you can retrieve files from a Time Machine backup. In the original iteration of Auto Save, you could click the title 
of a document and choose to lock it, duplicate it, revert to the last saved version, or browse all versions of the 
file. In Mountain Lion, the Auto Save menu becomes more useful. 

In addition to the aforementioned options, you find commands for renaming and moving files, as well as 
retrieving the last saved version of your file, once you’ve edited it. The commands you see depend on whether 
you’ve saved the file and where you’ve saved it.

EXTRA OPTIONS When you click the title bar of a file, you see more commands for 
altering that document 

For example, if you create a TextEdit document and type a single character, the file’s title shows Untitled—Edit-
ed. When you see the word Edited, that means Mountain Lion has automatically saved your file to iCloud—with-
out your having to invoke a Save command. This comes in useful should TextEdit inexplicably quit before you’ve 
saved changes in a file.

When you save the file, you have the option to save it in iCloud (provided you have an iCloud account and have 
granted your Mac access to it) or to your Mac. The title-bar drop-down menu also allows you to easily move 
files from iCloud to your Mac and vice versa. Just choose Move To iCloud if the file’s on your Mac; if the file is in 
iCloud, select Move To, and then select a destination on your Mac. Note that when you do this, the file disap-
pears from its current location (which is why the command is called “move” rather than “copy.”) If you’ve chosen 
to move it from iCloud, for example, it’s now available only on your Mac.
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Save a file, and then edit it without saving, and you can revert back to the last saved version by choosing the 
Last Opened command from this menu. If you’ve saved the file more than once and want to find a version older 
than the last save, you just invoke the Browse All Versions command, which brings up the Time Machine inter-
face familiar to Lion users. (The file’s previous versions aren’t stored in Time Machine, however, but on your 
Mac.)

A final convenience offered in this menu is the Rename command. Select it and the name in the title bar is high-
lighted. Type in a new name and press the Return key, and your document bears a new name.

MISSING BUT PRESENT Though the Save As command no longer shows up in the File 
menu, you can access it by typing Command-Shift-Option-S  

Attractive those these features may be, the one that’s likely to get the warmest welcome is the return of the 
Save As command. Under Lion, if you wanted to save a copy of a file under a different name, you had to dupli-
cate the file and rename it. Now, just press Command-Shift-Option-S to re-create the Save As behavior of old. 
(Regrettably, Apple reserves the former Save As shortcut, Command-Shift-S, for Duplicate.)
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Introducing the Improved Mac App Store
The Mac App Store makes it easier than ever to keep your software up to date. It can automatically download 
updates to any apps you’ve bought there. Ditto for OS X updates: They’re available on the Store (instead of via 
Software Update), and you can set them to download automatically. The Store also pushes apps purchased on 
one Mac to all your other Macs.

Finally, the Store itself is now trackpad savvy: You can navigate between pages in the Store by swiping left and 
right to move backward and forward, respectively, in your browsing history. 

Mirror Your Display with AirPlay
When iOS 4.2 debuted, Apple changed the name of AirTunes—the feature for streaming music from iTunes 
to an AirPort Express—to AirPlay, and in the process upgraded it considerably. In addition to streaming audio 
from iTunes on your computer, you could stream from any AirPlay-enabled iOS app, and you could even stream 
video to recent Apple TV models. In fact, as of iOS 5, you could actually mirror the screen of an iPhone 4S or 
later, or an iPad 2 or later—whatever that screen displayed, you could view on your TV through your Apple TV 
device.

AirPlay mirroring was such a great feature that people wanted it for their Macs. And in Mountain Lion, Apple 
has delivered—provided you have new enough hardware, of course. Specifically, if you’ve got a mid-2011 or 
newer iMac, Mac mini, or MacBook Air, or an early 2011 or newer MacBook Pro, you can send your Mac’s screen 
to any second- or third-generation Apple TV on the same local network and mirror it on any connected TV.

PLAY IT FORWARD Activate AirPlay Mirroring from the Displays drop-down menu 
(indicated by the TV screen icon) or from the Displays pane in System Preferences 

Using AirPlay mirroring is simple: Mountain Lion automatically detects if a compatible Apple TV is on your local 
network. If so, an AirPlay Mirroring pop-up menu appears in the Displays pane of System Preferences. (For 
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easier access, you can opt to display an AirPlay Mirroring menu in the menu bar whenever an Apple TV is avail-
able.) Choose your Apple TV in either menu, and in a few seconds your Mac’s screen appears on your TV, with 
the Mac’s audio playing through your TV or home-theater system. Apple says the video stream is encrypted for 
security and optimized to give you the best image quality without stalling or experiencing glitches.

MIRROR, MIRROR Open the Displays pane of System Preferences to tweak resolution 
and AirPlay mirroring 

Mountain Lion gives you a few options for choosing the best screen resolution, though your options depend 
on where you set them. From the system-wide menu, you can choose whether your Mac’s screen appears at 
its standard resolution on your TV or changes to match the TV’s native resolution—the latter option offers the 
sharpest image on your TV. In the Displays pane of System Preferences, you can choose your screen’s native 
resolution (Best For Display), the best resolution for streaming to your TV (Best For AirPlay), or any of the other 
resolutions supported by your Mac (Scaled). The Displays pane also lets you enable overscan correction.

(Note: Apple’s Mountain Lion features page says that AirPlay Mirroring supports up to 1080p HD, but Mountain 
Lion’s own Help system says that mirroring sends a 720p video stream with stereo audio.)

There are a few nice touches here. For example, if you play a video in iTunes while mirroring your Mac’s screen, 
the AirPlay Mirroring feature automatically switches the video to full-screen mode on your TV. And if you just 
want to listen to your Mac’s audio, you can use the Sound pane of System Preferences (or Option-click the 
system-wide volume menu) to choose any Apple TV or AirPlay-enabled audio device; you’re no longer limited to 
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iTunes audio for audio streaming.

In addition to being useful at home for watching movies, playing games, and surfing the Web on your big-
screen TV, the new AirPlay mirroring feature is a welcome addition for presenters and teachers. With an Apple 
TV and either an HDMI-compatible projector or an HDMI-to-VGA adapter such as the Kanex ATV Pro ($60), you 
can project your presentations and live demos from anywhere in the room—without wires.

http://www.kanexlive.com
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App Improvements

ALL IN THE APP Mountain Lion features updates to familiar OS X applications and 
introduces users to a few new programs  

What’s an operating system without its apps? In Mountain Lion (OS X 10.8), you’ll notice that Apple has added a 
few new apps to OS X while renaming and beefing up several more. iOS apps like Reminders, Notes, and Game 
Center make an appearance in the updated Mac OS, while old Mac stalwarts like iCal get name changes and 
feature improvements.

C H A P T E R  5
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New Apps
As Apple continues to port some of the best features from iOS to the Mac, it’s introducing new Mac apps that 
have iOS counterparts. These apps may not be new to anyone who’s used an iOS device, but Reminders, Notes, 
and Game Center are making their Mac debut in OS X Mountain Lion.

Reminders

Reminders is a place to store your to-do lists, tasks, and any other little bits you want to remember. If you’re fa-
miliar with the Reminders iOS app, you’ll feel right at home in the Mountain Lion version, which is a near perfect 
clone.

REMIND ME The Reminders app can help you remember tasks and to-dos 

As with the iPad version of Reminders, the OS X app presents a sidebar of all your lists on the left, with a faux 
sheet of wide-ruled loose-leaf paper on the right. 
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Because Reminders can sync via iCloud, your Mac and your iOS device can share one common set of to-dos. 
In lieu of a Preferences option under the Reminders menu, you’ll find Accounts; selecting it actually opens the 
Mail, Contacts & Calendars pane of System Preferences. There, you can add any iCloud accounts you’d like to 
use for syncing Reminders. Reminders also works with CalDAV services like Google Calendar and Yahoo Calen-
dar; you can similarly add those accounts in System Preferences.

To create a new list, you have three options: Choose File -> New List, double-click on a blank section within the 
Lists sidebar, or click the plus-sign icon (+) at the lower left of the Reminders window. The other buttons down 
there toggle the list sidebar and a small calendar that indicates which dates you have reminders scheduled for.

To delete a list, Control-click (or right-click) it and choose Delete. From the same contextual menu, you can also 
open a list in its own window or rename it.

Click on a list name to navigate between the lists. If you use a Multi-Touch input device (such as Apple’s Magic 
Trackpad), you can use two-finger swipes left and right to navigate across your lists instead. 

When you’re ready to start adding tasks, you again have multiple input options: You can choose File -> New 
Task, click on the next blank line on your list, double-click anywhere below the last task on your list, or click on 
the plus-sign icon (+) at the upper right of the Reminders window. 

THE LITTLE THINGS Click the i button to edit your reminder 

As you type in a new task, or after you hover over any task with the mouse for a moment, an info icon (a little i) 
appears on the right; click it to configure extra details for your reminder. You can instead double-click a task to 
accomplish the same thing.

http://www.macworld.com/article/1153031/magic_trackpad.html
http://www.macworld.com/article/1153031/magic_trackpad.html
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For any given task, you can specify when Reminders should remind you about it: You can choose to be remind-
ed at a specific date and time, or when you arrive at or leave from a specific location. Mountain Lion  allows you 
to set those reminders to any address of your choosing. 

LOCATION, LOCATION, LOCATION Reminders uses geofencing to remind you about a 
task when you enter or leave a place 

If you choose the At A Location option, you’ll be prompted to provide details about the location you’d like to 
use. You can either enter a contact’s name (provided that contact has an associated address in Contacts) or 
street address. Then you choose whether you wish to be reminded when you arrive at or depart from that loca-
tion.

Any scheduled reminders will appear in Notification Center on your Mac; you can snooze them or close them 
when they pop up. Snoozing resounds your reminder 15 minutes later—not just on your Mac, but on any 
iCloud-synced iOS devices.

Other per-reminder options include recurrence, priority level, and the ability to add a note. Adjusting priori-
ties doesn’t change where tasks appear in your list, but it does add an exclamation-point icon to indicate which 
tasks are more important. You can drag and drop to rearrange tasks, or even drag tasks between lists.

Keyboard navigation fiends, take note: You can type the first couple letters of a task to select it and then press 
Command-I to edit it. 

To mark a task as complete, you click its checkbox (or, with the task selected, press the spacebar). You can view 
all your completed tasks, across all your lists, by choosing the Completed list in the sidebar. To see per-list com-
pleted tasks, scroll up past the first item in the list to reveal its own Completed section.

Though iCloud offers support for shared Reminders lists, you can’t create such lists in the desktop app—in-
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stead, you’ll need to add them via the iCloud website.

Reminders also includes an integrated search box at the upper left of its window. Search results appear in real 
time as you type, with tasks due soonest listed first. Below those are matching completed tasks, oddly also 
listed with older due dates first—so you see completed tasks from long ago before you see more recent ones. 

The Mountain Lion version of the Reminders app is a faithful re-creation of its iOS counterpart, and it offers a 
straightforward way to add, edit, and check off to-do list items. The seamless sync with your iOS devices affords 
the fairly simple app some serious power; typing out your shopping list on your Mac and accessing it immedi-
ately from your iPhone turns out to be pretty great.

Notes

If you rummage around in your Mac’s Applications folder, you’ll find a copy of Stickies, a long-in-the-tooth appli-
cation for creating short notes that you can pin to your screen. It’s a limited notes application and one that few 
of us use any longer. Mountain Lion’s new Notes application, which takes its cues from the iOS app of the same 
name, may not replace Stickies in form—Stickies is still hiding out in the Applications folder—but it more than 
does so in functionality..

SCRIBBLE, SCRIBBLE Notes is linked to your Mail accounts, and it offers separate 
accounts for each 

Launch Notes and you see an interface very much like the Notes app. Unlike the iPad version, which sports a 
two-column view in landscape mode that shows you a list of notes and then the contents of a selected note—by 
default the Mac’s Notes application adds an Accounts column to the left of the Notes window. There you can 
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view all your notes by clicking on All Notes, or choose notes synced with a particular IMAP account—iCloud and 
a Gmail account, for example. 

Within this first column you can additionally create folders for filing your notes. Just choose File -> New Folder 
or Control-click in the Accounts column and choose New Folder. The new folder will appear under the currently 
selected account heading, but you’re welcome to drag it to another account. Once you’ve created a new folder 
you can drag notes to it or select the folder and create new notes that will be filed within it.

When creating notes you have three default font options—Noteworthy, Marker Felt, and Helvetica. If you like, 
you can use a different font by choosing Format -> Font -> Show Fonts and then selecting a new font from 
the Fonts window, but you can’t designate one of these fonts as the default, which is unfortunate if the three 
default fonts don’t appeal to you. When you create a new note, you’re back to the three default font options. 
However, Notes isn’t entirely limited in regard to formatting. You can create colored text, make text larger or 
smaller, format lists (in bulleted, dashed, and numbered styles), choose the alignment (left, center, justify, or 
right), assign a writing direction (left to right or right to left), and indent text.

Notes on the Mac is friendly to embedded links and attached files. To add a clickable link to a note, simply drag 
it into the note. Click on the link and your default browser opens and displays the linked webpage. Attaching 
a file is just as easy—drag it into a note. Image files will appear as pictures within the note. Files will display 
their icons and names. You can’t open larger versions of embedded images but you can open attached files by 
double-clicking on them. 

ADDED ATTACHMENTS Drag and drop files and images to add them to a note 

The ubiquitous Share button also appears within Notes. Click this button at the bottom of a note and you can 
send the note as an email or message attachment.

Lastly, if you love the ability to pin Stickies’ notes so that they always remain front and center on your Mac’s 
display, you’ll be pleased that you can do the same with Notes’ notes. Just double-click a note within the Notes 
pane and it’ll open in a new window. To unpin it, just click on the red Close button.
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Game Center

Like Reminders and Notes, Game Center is an app that’s seemingly been lifted wholesale out of iOS and 
dropped into Mountain Lion. Apple’s social network for gaming has made its way to the Mac, complete with the 
ability to see what your friends are up to and challenge them to games. 

GAME ON Keep track of your games and challenge your friends in Game Center 

Upon launching Game Center, you’re prompted to create an account or log in with an existing account. If you 
already set up a Game Center account on your iOS device, you can use the exact same account. 

As with the iOS version, the Game Center home screen allows you to update your status and add a photo (or 
change your existing photo). Thanks to OS X’s default picture chooser, you can even edit your photo using 
Photo Booth effects like sepia, black and white, heat vision, and more. The front page also includes icons of vari-
ous Mac App Store games; clicking any of them will take you to the relevant page in the Mac App Store.

On the Friends page, you’ll see a list of your friends, along with the ability to get friend recommendations by 
uploading your Mac’s contacts or add friends directly by entering their email address or nickname. Existing iOS 
users of Game Center should see all of their same friends after logging in to Game Center in Mountain Lion.

The Games page shows one of the few differences between the iOS and OS X flavors at present. Namely, it’ll 
show you both your OS X games and your iOS games. If you don’t have any games, you can click on the empty 
box’s Find games on the App Store link to be taken to the Mac App Store (the Find Game Center Games button 
at the bottom does the same thing). 
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CHESS CHEEVOS You can view your achievements (and which ones you still have left to 
accomplish) within an OS X game, thanks to Game Center Integration 

Clicking any of your games will show you information about your play online, such as rank, achievements, and 
how you stack up against your friends.

Of course, Game Center’s impact isn’t felt solely within the confines of its app. As on iOS, games can take advan-
tage of Game Center’s features to allow for easy multiplayer functionality, potentially helping game developers 
avoid reinventing the wheel. 
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PLAY PROMPT When you open a Game Center–enabled game and you haven’t signed in, 
it will prompt you to link your account or create a new one 

Since invitations are integrated with Mountain Lion’s Notifications feature, you can ensure that you’ll never miss 
another opportunity to play. And, best of all, Game Center can bridge the divide between iOS and OS X, allowing 
cross-platform play for games that ship for both systems.

Game Center even enables in-game voice chat that lets you trash talk—or, if you prefer cooperative games, 
coordinate—with your friends. That means you don’t necessarily have to fall back to Skype or iChat in order to 
hear your friends’ cries of defeat as they fall before you.

Finally, for parents concerned about their children’s gaming habits, Game Center works with OS X’s Parental 
Controls, allowing you to prevent your kids from joining Game Center multiplayer games or from adding new 
Game Center friends.

Renamed Apps
OS X Mountain Lion includes a number of new apps that made their debut on iOS, including Reminders, Notes, 
and Game Center. But to further the OS X–iOS convergence, a few Mac favorites will sport new names in Moun-
tain Lion—names that will look very familiar to iPhone, iPad, and iPod touch users.

Contacts and Calendar

Among the least-popular changes in OS X Lion (OS X 10.7) were those performed on iCal and Address Book. 
From their unnecessarily skeuomorphic interfaces to the omission of features once found in Snow Leopard, 
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these two apps have, in many a user’s mind, earned the criticism they’ve received.

Which explains why many Mac users will welcome the updated versions of iCal and Address Book—now called 
Calendar and Contacts, respectively, for consistency across all of Apple’s computing devices—provided in 
Mountain Lion. While they don’t fix all issues present in their Lion counterparts, each offers a number of signifi-
cant improvements.

CONTACTS While many iOS users will welcome Contacts based on the name change alone—especially if, like us, 
you often attempt to launch your address book in Spotlight by typing contacts—the biggest improvement to 
the app is the return of the three-column layout. 

MEET CUTE Contacts has a new three-column view 

Gone is the need to click a virtual bookmark to ever-so-slowly turn virtual pages; instead, you can choose from 
three display modes: card (single column); card and contacts (two columns); or card, contacts, and groups 
(three columns). To retain the app’s book-like design, the three-pane view narrows your contacts list, allowing 
the Groups sidebar to sit on the far left of the page.

If you’d like, you can switch between three-, two-, and one-column views by clicking the appropriate buttons at 
the bottom of the Contacts pane.

The app also addresses an issue that’s confounded users for years—multiple contract entries for one person. 
Thanks to the variety of services plugged into the app (including iCloud, Yahoo, and Google), the new version 
of Contacts presents a unified view that incorporates contact information from these multiple sources into a 
single contact. So if you’ve stored Sally Jones’s street address in iCloud, her phone number on Yahoo, and her 
email addresses in your Google contacts, Contacts will create a single entry that includes all of this information.

Contacts also expands upon the Share button. Under Lion, if you selected a contact and then clicked on the 
Share button at the bottom of the window, Mail would open and create an unaddressed email message with 
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the contact attached as a vCard file. With Mountain Lion, you’ll also be able to send an iMessage with the card 
attached or send it via AirDrop to a local computer.

CALENDAR Two of the changes to Calendar in Mountain Lion will be immediately obvious. On the aesthetics 
side, Apple has gotten rid of the gaudy faux stitching. 

SCHEDULED AFFAIRS The Calendar interface is cleaner, with fewer popovers 

The program’s interface still tries a bit too hard to look like a physical desk calendar, but the new look is a bit 
more subtle. The bigger change—and the one that will likely be the most welcome by iCal’s critics—is that 
Calendars in Mountain Lion brings back the dedicated calendars sidebar. Instead of requiring that you click a 
button to view your list of calendars, Calendars provides that list, organized by calendar type, in a Snow Leop-
ard–style sidebar on the left side. Below that list is a mini calendar view that, by default, displays the current 
month and the upcoming month (though you can drag the calendar divider up or down to increase or decrease, 
respectively, the number of visible months).
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KEYWORD CALENDARING Search your calendar events with keywords and search 
tokens 

One small—but welcome—change is the addition of Apple’s OS X search tokens (which debuted in the Finder 
and Mail with Lion) for Calendar’s events search. Instead of having to detail the kind of information you’re 
looking for off the bat, Calendar intelligently tries to suggest categories as you type; categories can include 
organizers, event titles, and notes associated with an event. Just like with Finder or Mail searches, you can stack 
categories: For instance, you could search for any events organized by Macworld with the name meeting. 
Search results have also been redesigned, appearing instead in an abbreviated form along the right side of the 
app window.

To display those results, Calendar excises the reminders sidebar; because Mountain Lion includes a dedicated 
Reminders app, you’re expected to manage tasks and reminders from within that program instead. Of course, 
this also means that if you want to create any sort of to-do, you need to hop over to Reminders to do so; unlike 
with Contacts, there’s no direct link to the Reminders app in Calendar.

The other major change in Calendars is that Apple has completely revamped alerts and event reminders. For 
each of your accounts, you can now customize your default alerts, individually, for timed events, all-day events, 
and even birthdays; each of these can be set to occur a chosen number of minutes, hours, or days before an 
event. And instead of tossing up an alert window when an alarm goes off, Calendar alerts will appear in Moun-
tain Lion’s Notification Center. 

You’ll also find a few minor interface changes. For example, the Calendar menu is gone, with its commands 
redistributed among the File, View, and Edit menus. And you can now disable the heat-map effect for Year view 
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(the one that shows lightly scheduled days in light colors and more heavily scheduled days in darker colors).

Messages

Messages isn’t just iChat with a new name. Instead, it’s a substantial rethink of the way instant messaging is 
done on the Mac, one that ties the Mac more tightly to iOS.

MESSAGE ME Messages is now your desktop hub for iMessages, AIM, Google Chat, and 
other instant messaging services 

The feature that transmogrifies iChat into Messages is support for Apple’s iMessage chat system. When Apple 
introduced iMessage, people focused on how it’s similar to the SMS text-messaging system on phones. And yes, 
it’s cool that iPhone users can send text and multimedia files over the Internet without any of the per-message 
charges that wireless carriers levy for texts. But that misses the bigger picture: By using the Internet instead of 
the cellular system, devices that aren’t phones can join the party. iOS 5 gave the iPad and the iPod touch iMes-
sage capabilities too, and now it’s the Mac’s turn.

iMessage supports some nice extra features such as the ability to (optionally) send information about whether 
you’ve received and read a message, and when you’re in the process of sending a reply. To send a message to 
someone using iMessage, you need to know their Apple ID (which is usually based on their email address and 
may also be their iCloud username). Using the iMessage system, you can send text, pictures, and other attach-
ments. 
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STUFFED SEND You can message files, including images, to your friends 

If you need to talk with more than one friend, there’s even support for multiperson chats. It’s all encrypted, 
and it works no matter if you’re on an iPhone, iPad, iPod touch, or a Mac. And if you’re logged in to iMessage 
on multiple devices, your conversations will go with you—you can start a chat on a Mac and end up on an iPad, 
with your entire conversation available for reference.

Though the name is now Messages, the features of iChat are more or less intact. The app still supports AIM, Ya-
hoo, and Jabber protocols. (Since Google’s chat system uses Jabber, Messages therefore supports Google Talk, 
too.) There’s still a buddy list and still support for audio and video chats and screen sharing via those services. 
iChat Theater is still there, too—it’s just called Theater now, and is accessible once you start a video chat from 
the Buddy List.

STILL ALIVE You can still create video and audio chats, or share the screen with a buddy, 
but only through AIM 

The major interface change in the upgrade from iChat to Messages is the new Messages window. This is a new, 
persistent window that collects all your currently active conversations, regardless of which service they’re on.
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The left pane of the Messages window is a scrollable list showing every conversation, with the name and buddy 
icon of any people you’ve recently messaged with, a portion of the most recent message in the conversation(s), 
and the time or date the most recent message was sent or received. You can remove items from the left pane 
by moving your mouse over one and clicking the X icon that appears. Pressing Command-W will also remove 
the currently selected item. (You can double-click any of the items in the left pane to open them in a stand-
alone window, if you prefer to have several, separate chat windows open at once.)

The right pane of the Messages window is the chat area. There’s nothing too dramatically different here; The 
text-entry box at the bottom of the pane displays the name of the service you’re using for a particular chat, 
until you begin typing. At the top of the pane, there’s a camera button that gives you quick access to video chat. 
FaceTime is the primary objective here: Messages will show you every phone number and email address for the 
person you’re chatting with, in hopes that one of them will be valid for FaceTime use. If you just want to use AIM 
to chat with them, you have to scroll down to the Other submenu and then pick an account.

Even though Messages links to FaceTime, it’s important to note that Messages doesn’t actually do FaceTime. 
When you select a FaceTime address and initiate a FaceTime session, Messages opens the FaceTime app and 
initiates the connection. The two apps remain separate.

The bottom line is that this is a really new app—not just an upgrade to iChat, but a brand-new way to think 
about and manage chats.
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Updated Apps
Apple chose three of its oft-used programs—Mail, Safari, and Preview—to update in Mountain Lion. All three 
receive iCloud and sharing integration, along with a few extras here and there. Several other OS X apps also get 
a few small tweaks with this version of the operating system.

Mail

When Apple released Lion, Mail received its biggest overhaul ever, gaining many new and noteworthy features. 
The changes to Mail in Mountain Lion are more subtle, though there are some nice improvements—along with 
one significant omission.

FINDERS, KEEPERS You can search within the body of your Mail messages using inline 
find 

INLINE FIND Mail has always let you find text within the body of an email message, but in the current version 
of Mail, you use a separate Find dialog box that highlights only a single result at a time; to find subsequent 
instances of your search string, you repeatedly click the Next button (or press Command-G). Mail in Mountain 
Lion gains a Safari-like inline find feature: Press Command-F (or choose the Find command in the Edit menu) 
and type your search string—in a field just above the body of the current message, rather than in a separate 
window—and the body of the message is dimmed, with every occurrence of your search string displayed. You 
can use the arrow buttons next to the search field, or their keyboard-shortcut equivalents, to cycle through oc-
currences.

You don’t lose the capability to use Find & Replace, however. Whenever you do an inline find while composing a 
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message, a Replace checkbox appears; check the box, and you can enter your replacement text, with options to 
replace just the current instance or all instances of the search string. The location of the find/replace fields with-
in the current message window is more convenient than a separate Find window, and it reduces screen clutter. 
It’s also less confusing, as you’ll never see a Replace option for an incoming message. On the other hand, you 
lose the Lion option to perform case-sensitive searches, but we suspect this won’t be an issue for most users.

VIPS We all have particular people—our family members, our boss, our bookie—whose messages are more 
important than others. While Mail in Lion let you use combinations of rules, labels, and mailboxes to make a 
particular person’s messages easier to identify or view, Mail in Mountain Lion adds a new feature that’s custom-
made for such purposes: VIPs.

VERY IMPORTANT PEOPLE Designate certain folks as VIPs to have their emails produce a 
special alert 

A VIP is any person you designate as being important enough to have their messages treated differently by 
Mail. You designate someone as a VIP by clicking the star icon to the left of the person’s name in any incoming 
or sent message. You’ll immediately notice that every message to or from that person now displays a star in 
message lists, making it easier to find those messages. In addition, when you designate a sender as a VIP, that 
person gets his or her own entry in a new VIPs section of Mail’s Mailboxes sidebar. Click a VIP’s name, and you 
get a list of all messages, across all mailboxes (including Sent and Trash), to or from that person.
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You can also take advantage of VIP status in mail rules: Mail includes a new condition called Sender Is VIP. 
Combine this with the new Send Notification action mentioned above, and you can configure Mail to notify you 
whenever email arrives from one of your VIPs. Of course, you can also use any other available mail action on 
messages from a VIP.

NOTIFICATIONS Mail takes advantage of Notification Center to alert you to new messages, but instead of 
displaying a notification for every new message, as with iOS, OS X Mail lets you choose which new messages 
should trigger notification alerts: messages in any mailboxes, messages that land in your Inbox, messages from 
your contacts, or messages from people you’ve designated as VIPs.

ALERT THE MASSES If you configure them as such, Mail messages will show up in 
Notification Center as alerts 

You can also use notifications in Mail rules because of a new option for rule actions called Send Notification. 
Using this feature, you could configure a rule to display a notification whenever you receive a message sent to 
your work email address, but not to your personal account.

R I P  RSS One thing you won’t find in Mountain Lion’s Mail app—at least as it stands today—is the RSS fea-
ture. Whereas in Lion you could subscribe to an RSS feed in Mail to be alerted to, and to read, newly published 
articles from your favorite websites, that feature is gone from Mail in Mountain Lion. Mail’s preferences window 
has been stripped of the RSS pane, and the Add RSS Feeds command in Mail’s File menu is no longer there.

RSS functionality is also missing from Safari in Mountain Lion; as such, if you want to read RSS feeds in Moun-
tain Lion, you’ll have to turn to a third-party app.

MISCELLANEOUS TWEAKS If you’re deep in a list of messages, you can quickly go back to the top of the list by 
clicking on the sort bar at the top. And as with many other Mountain Lion apps, Mail is connected to iCloud: 
Your preferences are pushed to iCloud, where they can be synced with the Mail app on your other devices.

Safari

Apple’s native Web browser, Safari, has a whole new array of features to show off in Mountain Lion. While some 
of those features are simply improvements on existing amenities, others are completely new—either inspired 
by other popular browsers or by Apple’s ambition to make OS X and iOS work together as seamlessly as pos-
sible. 
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SURFIN’ SAFARI Apple’s Web browser sports a new unified search bar, a prominent 
button for Safari Reader, new tabs, and more 

For Google Chrome and Mozilla Firefox users, this new Safari is going to feel very familiar, as many of its new 
features are similar to features that stand out in those other browsers. But Safari die-hards should fear not, for 
these changes will take little to no time to adjust to. 

TABS AND SMART SEARCH Perhaps the most useful new feature is iCloud Tabs. Clicking the new iCloud Tabs 
button will give you a live listing of open Safari tabs on all of your iOS and OS X machines linked to your Apple 
ID and iCloud account. That way, you can start reading something on your iPhone and then switch to your Mac 
later and pick up where you left off.

This new Safari comes with a new navigation tool called Tab View for switching between tabs. You can now 
use Multi-Touch gestures on a trackpad to switch between your open tabs—just pinch in to reveal all your 
open tabs, and then switch between them with a two-finger swipe left or right across the trackpad. These new 
gestures are comfortable and intuitive, because they mimic familiar iOS Multi-Touch gestures. Visually, tabs are 
also more elongated across the top—three tabs (or two, or four, or however many tabs you have open) will fill 
the span of the window instead of being divided into shorter tabs. 

Another new feature is the Smart Search Field, which (as Chrome does) unifies the address bar and search field. 
It looks much cleaner than the separate search and URL fields that Safari previously used, and it performs well 
to boot. The idea here is that you type keywords directly into the URL slot, and Safari suggests some pages that 
might be what you’re looking for.
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SEARCH AND DISCOVER Type a word in Safari’s Smart Search Field, and see the Top Hits, 
suggested Google search queries, hits from your bookmarks and history, and other 

options for search 

For example, if you type Apple in that one text field, you’ll get a sectioned list of suggestions. The first section—
Top Hits—will show www.apple.com. Below that, Safari offers some possible Google searches (apple, apple 
store, and so on); Google is the default search engine, but you can change it to either Yahoo or Bing in Safari’s 
General preferences. Below Google Search you’ll see entries from your history and bookmarks list that match 
the search string. As with older versions of Safari, the only sites that appear in Top Hits are those you’ve visited 
or search terms you’ve looked for before. Results improve the more you use this feature.

PASSWORDS AND PRIVACY When you log in to a website, Safari offers to save your password for AutoFill, so 
you don’t have to type it the next time you log in. It keeps a running log of all your saved passwords and login 
info, which you can edit at any time by taking a look at your preferences. It also keeps track of which sites 
you’ve declined for Safari to remember your password. The Password preferences tab lets you remove or add 
passwords to your chain, and if you forgot a saved password, you can click the Show Password box to reveal 
them. Previously, Safari displayed only usernames for the allotted sites, though it could remember passwords.

http://www.apple.com


70

C H A P T E R  5   App Improvements

PASSWORD PROTECTION Before seeing a list of stored passwords and usernames, you 
must first enter your master password 

If this sounds a little insecure, don’t fret—you’ll be prompted to enter your Mac’s master password first (the one 
you set up in the Security & Privacy preference pane), so other users won’t have access to your saved pass-
words. For those of you who use a shared Mac with different user logins, make sure you’re logged in to your 
account before saving password logins.

Safari’s updates to password saving and AutoFill now feel more complete. It also is a bit more secure than 
Firefox’s and Chrome’s stored passwords, which can be viewed by anyone who knows where to look. 1Password 
and other password utilities provide an even safer password storing solution, but Safari’s is pretty solid.

Though older versions of Safari offer a Private Browsing option, Safari now supports an emerging privacy stan-
dard called Do Not Track. Previously, this option was a hidden feature in Safari’s advanced Develop menu, but 
now it’s easier to find and use. When you turn on the Do Not Track option or surf the Web with Private Brows-
ing enabled, Safari asks the websites you visit not to track you online. Under the Privacy tab in Safari’s Prefer-
ences, check the box that reads Website Tracking: Ask Websites Not To Track Me to turn this option on. 

Private Browsing is still available. When you turn Private Browsing on, a pop-up notification reminds you of 
what this function does: “Safari can keep your browsing history private. When you turn on private browsing, 
Safari doesn’t remember the pages you visit, your search history, or your AutoFill information.” A tag that reads 
“Private” will appear in your unified search bar, and it applies to all open tabs in your open Safari session. 

http://www.macworld.com/article/1155446/1password3.html
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This isn’t a completely original feature—Google Chrome sports the Incognito feature, and Firefox also has a 
private-browsing feature that can be enabled. If you’re already logged in to a site that requires a username and 
password, you’ll be logged out, because Private Browsing doesn’t keep track of any passwords, regardless of 
whether you’ve saved any in your AutoFill. 

OTHER FEATURES There are plenty of other nice little tweaks in this new Safari.

The offline Reading List feature is particularly welcome, especially when paired with Safari on your mobile 
devices. To save a page to your reading list, go to Bookmarks -> Add to Reading List, or press Command-Shift-D. 
Safari then saves the page in your Reading List so you can catch up on your reading even when you don’t have 
an Internet connection. If an article in your Reading List contains multiple pages, Safari fetches the pages and 
stores them, so you can read the entire article offline.

Thanks to hardware acceleration, webpages scroll smoothly in the browser window even when your Mac is 
loading new webpage content. You can see the status of the loading page by checking out your search bar—the 
bar will display a blue status bar that starts on the left and loads toward the right. Thanks to smooth scrolling, 
you can start reading or viewing a page as it loads. Just start scrolling down. The new Safari also speeds up Java-
Script performance; the difference is noticeable.

SHARING FOR GOOD Safari now has a built-in Share button like its OS X app siblings 

As in so many other Mountain Lion apps, Safari has a Share button. This handy tool right next to the unified 
search bar lets you quickly add pages to your Reading List or save them as bookmarks; you can also send pages 
to someone else via Mail, Messages, or Twitter; Apple says that Facebook integration is coming. And Safari also 
works with Notification Center; websites can ask for permission to show alerts.
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Preview

Apple’s Preview application has always been great for doing quick edits on photos and annotating PDFs, but as 
the company piled more features into the program, everything started getting a little bit cluttered. In Mountain 
Lion, Preview turns down the visual noise without losing any vaunted features.

A PERFECT PREVIEW The new Preview has simplified the toolbar without simplifying the 
tools of the program 

Preview’s newly refined toolbar takes a cue from iPhoto and Apple’s best iOS apps, simplifying tools behind sin-
gle buttons. The app also uses Apple’s Documents in the Cloud feature, which allows you to store files remotely 
so that you can access them from any computer.

The left side of the toolbar holds a button for displaying pages (for PDFs) or multiple selected images as thumb-
nails, buttons for zooming, and a Share button.

Along the right side of the toolbar, there are three big buttons—Markup, Rotate, and Edit—next to a search bar. 
Click on Edit, and a sub-toolbar drops down with more options for your corrective needs.

On a PDF, Markup works similarly to Apple’s iBooks software: Highlight text by selecting it and then Control-click 
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to choose your color and whether you want to add a note. You can also underline or strike through text. You 
can view all your notes and highlights at once in the sidebar (by choosing View -> Highlights And Notes). You can 
also search notes and highlights by author and/or by content.

FILLED OUT Enable the Edit button to quickly fill out PDF forms 

Preview has also gotten a lot smarter about filling out forms. While previous versions let you do things like 
inserting your signature, the new version detects areas intended for text entry (such as underlines and boxes) 
and, when you click on them, lets you enter your information. You can also click to select checkboxes.

Other App Changes

Though not as flashy as those found in Mail or Preview, Chess, Font Book, Photo Booth, QuickTime Player, and 
TextEdit all receive minor updates in Mountain Lion.

Chess is now Game Center–compatible, and you can track your achievements and challenge friends from within 
the app.

Font Book allows you to create Smart Collections of your favorite fonts based on search terms.
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PHOTO BOMB’S AWAY Share images in Photo Booth or set a profile picture  

You can now set any Photo Booth image as your Twitter profile picture, and share pictures with friends via Air-
Drop, Messages, Mail, Facebook, Twitter, Flickr, and Vimeo.

QuickTime X has new sharing options to AirDrop, Messages, and Mail, and movies can now be exported in high 
definition, using a new high-performance version of the H.264 codec.

To zoom in TextEdit documents, you can now use pinch gestures; documents can also be saved remotely using 
Documents in the Cloud.
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The Gatekeeper
The marquee security feature in Mountain Lion is Gatekeeper—but you won’t find a new pane in System Prefer-
ences with that name. Instead, you open up the Security & Privacy preference pane and then click the lock in 
the lower left corner to fill in your administrator authentication. Under the General tab of that pane is a head-
ing, Allow Applications Downloaded From, with three options. That’s the front end for Gatekeeper.

As you’d surmise, those three options let you specify which apps are permitted to run on your Mac. You can 
choose to run only those apps downloaded from the Mac App Store, apps from the Mac App Store and identi-
fied developers, or apps from anywhere. 

IDENTIFY YOURSELF Mountain Lion won’t let you open or run an app if it doesn’t meet 
the criteria you’ve set within System Preferences 

The first and last options are straightforward: The first limits your Mac to running apps from the Mac App Store; 
the last places no limitations on the apps your Mac can run. The middle option—allowing apps from the Mac 
App Store and identified developers—merits additional explanation: Any developer can freely register with Ap-
ple and receive a unique certificate with which to cryptographically sign their apps. Thanks to that signing, your 
Mac knows which developer is behind a specific app, and it can tell if some nefarious third party has mucked 
about with a signed app before it got into your hands. 

If a developer’s signed app is found to behave maliciously, Apple can revoke that developer’s identity certificate, 
which would in turn warn users before they could install the app.

One very important note is that Gatekeeper only works its protective magic the very first time you launch an 
app. In other words, if you upgrade to Mountain Lion on your Mac and choose the Mac App Store–only Gate-
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keeper setting, you can still freely launch any other apps on your Mac that came from elsewhere, provided 
you’ve run them in the past on that Mac.

DOUBLE CHECK Even if you’ve OK’d non–Mac App Store apps, OS X will always check 
with you before running an app for the very first time 

Most Mac users have already encountered messages similar to the ones Gatekeeper will pop up: In previous 
incarnations of OS X, your Mac asked you to confirm your intentions when you first launched any app down-
loaded from the Internet. With Gatekeeper, the warnings are new, but the general experience is the same.

Should you come across an app that your Gatekeeper settings prevent from launching, you needn’t dive into 
System Preferences to fix things. Instead, Control-click (or right-click) on the icon of the app you’re attempting 
to run, and choose Open from the contextual menu that appears. You’ll see a variant of the warning dialog box; 
this one adds an option to go ahead and launch the app despite Gatekeeper’s grave concerns. Once you’ve 
done that, you can launch the app normally from then on.

Other Security Improvements
In addition to Gatekeeper, Mountain Lion leverages a variety of other technologies to help keep your Mac 
secure. It uses Kernel Address Space Layout Randomization (ASLR), which makes it much harder for malicious 
attackers to exploit low-level system functions on your Mac, since the locations of those functions in memory 
change each time you reboot.

Mountain Lion also builds upon Lion’s sandboxing requirements for apps. Sandboxing, to those unfamiliar, 
requires an app to specifically request what it wants to do with your Mac, rather than have a blanket license to 
do what it will. This prevents an app from performing malicious activities upon your Mac, and it also limits what 
a potentially security-compromised app can do. All new Mac App Store apps are sandboxed; in addition, several 
Apple-provided apps are sandboxed in Mountain Lion,—among them FaceTime, Mail, Reminders, Notes, Game 
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Center, and Safari. (Of course, if you can’t trust Apple’s own apps not to access data they shouldn’t, that’s a big-
ger issue.)

Advanced FileVault users can now leverage management updates to the fdsetup command-line tool, which in 
Mountain Lion allows third-party software to control and configure various FileVault features.

LOCATION SITUATION You can choose which apps to allow or deny location information 
to within the Security & Privacy preference pane 

The new Privacy tab in the Security & Privacy system preference lets you manually control which apps can ac-
cess your location data, contacts, and Twitter credentials. As on iOS, you’ll be able to see at a glance which apps 
have requested access to your location in the past 24 hours, too. And you’ll need to provide explicit approval on 
an app-by-app basis to allow software—even Apple software—to access your contacts or location.

Finally, Mountain Lion will check for software updates daily. In previous versions of OS X, you could manually 
configure how often the system would check for updates; the default was once per week. But in Mountain Lion, 
Software Updates move to the Mac App Store, which can check for updates even when it’s not running. You’ll 
receive a Notification Center alert whenever new OS X updates are available. So when or if new Mac-focused 
malware starts to spread and Apple issues a fix, Mac users should at least be aware of the fix’s availability more 
quickly than they may have been before.
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Thanks for Reading!
We hope you’ve learned a bit more about OS X Mountain Lion thanks to this Superguide, and that you’re ready 
to install Apple’s operating system and venture forth. For more books about the Mac, iOS, and all things Apple, 
check out the other books in our Superguide program.

And visit Macworld.com for the latest tips, tricks, how-tos, and news about the iPhone, iOS, and all of Apple’s 
other products.

http://www.macworld.com/superguide/
http://www.macworld.com/
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